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  Numero 17


  

  



  Benvenuti ad un altro numero di Full Circle Magazine.


  Questo mese abbiamo una nuova serie per voi: Come programmare in C. C è sicuramente il re dei linguaggi di programmazione. Se desiderate programmare nel linguaggio più usato e più tenuto in considerazione, allora questa nuova serie è senza dubbio per voi. Inoltre presentiamo un articolo particolarmente lungo in "La mia storia" di David Rowell, che ci mostra una sua linea temporale dalle cartelle forate del Fortran al suo uso corrente di Ubuntu (qualcuno conosce il codice morse?). E infine sono state apportate alcune piccole modifiche estetiche alla rivista.

  

  Molte persone ci hanno chiesto dei file PDF contenenti una intera serie. Noi (io e altri del forum) stiamo creando un PDF dei miei tutorial su Scribus e, appena lo completiamo, creeremo un PDF della serie "Creare il vostro server". Per cui occhio alle prossime pubblicazioni. Il nostro canale IRC è divenuto ultimamente piuttosto tranquillo (la frase dell'anno!) così per tentare di vedere voi, ottima gente, su IRC abbiamo pubblicato un How-To su come connettersi a IRC. Non solo per avere delle persone nel nostro canale, ma anche perché è il modo migliore e veloce per ottenere aiuto quando avete delle domande sia su Ubuntu che su un'applicazione in particolare. Allora prendetevi il tempo per imparare ad usare IRC; è come avere un centro aiuto 24 ore su 24 a vostra disposizione. E non dimenticate di visitare il canale di Full Circle dove potrete dire la vostra su cosa vi piace (o non vi piace) della rivista.

  

  I migliori auguri,

  

  Ronnie

  Caporedattore, Full Circle Magazine

  ronnie@fullcirclemagazine.org


  

  



  Comanda e Conquista


  Scritto da Robert Clipsham


  Se avete seguito le guide fin qui, adesso dovreste conoscere le basi per stare sicuri e gestire i file da riga di comando. Questo mese vi faccio vedere come modificare i file usando Nano e Vi/Vim.

  

  Per iniziare, vi mostrerò il più semplice dei due editor, Nano
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  Nella parte superiore vedrete tre cose. A sinistra "GNU Nano" seguito da un numero di versione, al centro il nome del file e a destra lo stato del file. In basso ci sono due righe di comandi per il programma di composizione dei testi, quindi appena sotto la linea di stato. Per modificare il file iniziate semplicemente a scrivere come fareste con qualunque altro editor!

  

  Oltre a modificare il file, le funzioni comuni (e le loro combinazioni di tasti) sono elencate in basso. Per esempio, ^O (Ctrl+O) eseguirà "Salva" ossia salva il file e ^W (Ctrl+W) vi permetterà di cercare un determinato termine nel file. Scrivete un po' di testo nel file, quindi salvatelo. Nano è il più semplice dei due programmi da usare, ma le sue funzionalità sono molto minori rispetto a Vi o Vim.

  

  Come impostazione predefinita, Ubuntu possiede solo il pacchetto base di Vim, senza tanti fronzoli. Questo sarà sufficiente per il tutorial, ma per un editing avanzato avrete bisogno del pacchetto completo (vi mostrerò come ottenerlo utilizzando la riga di comando nella prossima guida).

  

  I programmi di gestione di testi fanno principalmente due cose: modificano i file e automatizzano i compiti. Questi ultimi possono essere i più disparati da trova/sostituisci a quello semplicemente di salvare un file. Negli editor grafici questo avviene attraverso un menu o premendo dei bottoni. In Nano voi utilizzate alcune combinazioni di tasti per compiere questi compiti. Vim possiede due modalità per queste funzionalità: una modalità inserimento e un modo comando. Vim (sotto) si avvia in modalità comando di default, così non sarete in grado di modificare il documento.
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  Per passare alla modalità inserisci, premete "i" o il tasto insert. Ora sarete in grado di modificare il file. Inserite alcune linee aggiuntive di testo, quindi tornate in modalità comando premendo il tasto escape. Ci sono centinaia, se non migliaia di comandi in Vim, che forniscono un gran numero di funzioni. Alcuni dei comandi principali sono illustrati in Fig.1

  



  
    
      
        	Comando

        	Funzione
      


      
        	:w

        	Salva il documento
      


      
        	:q

        	Esce da Vim
      


      
        	:q!

        	Esce da Vim senza salvare
      


      
        	h,j,k,l

        	Per muoversi dentro il documento, utilizzando anche i tasti freccia
      


      
        	:e [filename]

        	Apre il file desiderato
      


      
        	:help [command]

        	Apre la pagina principale dell'aiuto o per ottenere un aiuto specifico
      


      
        	:set [option] [value]

        	Si ottiene una lista delle opzioni attuali o ne può settare una
      

    
  


  Quindi, per esempio, se volete salvare le vostre modifiche, scrivete ":w" (tutti i comandi di Vim iniziano con ":"). Potete anche combinare i comandi, come per esempio ":wq" che salva ed esce da Vim.

  

  Questi sono solo alcuni dei comandi base che ha Vim. Ci sono anche comandi per copia/incolla, trova e sostituisci, per evidenziare la sintassi, mostrare i numeri di riga e anche altre funzioni avanzate. Se volete più informazioni usate :help o leggete la documentazione su http://www.vim.org/docs.php.

  

  Robert Clipsham è un geek (lett.:appassionato di computer) reo confesso, le cui passioni includono: programmare / realizzare script, chattare in IRC e non scrivere gli articoli in tempo.

  



  How To

  Programmare In C - Parte 1


  Scritto da Elie De Brauwer


  Questo articolo è il primo di una serie che si concentrerà su come divertirsi col linguaggio di programmazione C. Nel primo articolo introdurremo il linguaggio C e qualche concetto elementare sulla programmazione per i principianti. In questo modo, gli utenti inesperti, potranno essere in grado di seguire la serie e di portarsi a un livello in cui sono in grado di scrivere e capire delle semplici applicazioni in C. Non appena le basi del linguaggio saranno state spiegate, introdurremo, attraverso degli esempi, nuovi concetti, tecniche e criteri medio-avanzati. Qui vi prometto che farò del mio meglio per non effettuare salti troppo grandi e di introdurre i nuovi concetti man mano che li incontreremo. Se qualche lettore incontrasse dei problemi, o fallisse nel capire correttamente certe cose, non esiti a contattarmi.

  

  Perché il C ?

  

  Oggigiorno ci sono numerosi linguaggi di programmazione e la domanda perché usare "A" e non "B" ha condotto a discussioni senza fine. Una prima risposta è che il C è ancora un linguaggio molto diffuso. Una seconda motivazione è il legame tra UNIX e C; inizialmente il C fu sviluppato dai Laboratori di AT&T Bell tra il 1969 e il 1973 da Dennis Ritchie, e il kernel UNIX fu il primo importante progetto implementato nel linguaggio. Oggi il numero di progetti software (open) scritti in C è ancora enorme, il più conosciuto è probabilmente il kernel Linux stesso. La maggiore obiezione all'apprendimento del C è che non è un linguaggio moderno; per esempio manca di framework estesi e non è orientato agli oggetti, cosa che fa del C un linguaggio semplice da imparare. D'altra parte una valida obiezione è che, dato che il C è un linguaggio strettamente collegato all'hardware, permette agli utenti di fare cose che non dovrebbero fare. Se volete davvero spararvi su un piede, il C non vi impedirà di farlo.

  

  Preparare il vostro sistema

  

  E ora la parte che fa paura, è giunto il tempo di sporcarci le mani. Se visitate un forum o newsgroup relativo alla programmazione incontrerete, ad intervalli regolari, qualcuno che vuole iniziare a programmare e fallisce nella compilazione/esecuzione del primo esempio che incontra nel sito (o in una rivista). Debian/Ubuntu ha previsto, specialmente per i programmatori principianti, un metapacchetto speciale chiamato "build-essential". Eseguite:

  

  sudo apt-get install build-essential

  

  il vostro sistema sarà equipaggiato con tutto il necessario per compilare una semplice applicazione C (tra gli altri il compilatore GNU GCC e make). In questa serie non vogliamo insegnarvi l'utilizzo di un IDE (Integrated Development Environment, Ambiente di Sviluppo Integrato, una suite grafica che esegue debug, edit, compilazione e include, preferibilmente, qualche aiuto contestuale per gli utenti). Ci sono alcuni IDE eccellenti come Anjuta, KDevelop, Code::Blocks ed Eclipse assieme a CDT. Naturalmente siete liberi di provarli, ma vi suggerisco di imparare a programmare col vostro editor di testo preferito come Emacs, Vi, Vim, Kate e numerosi altri. Scegliete semplicemente un editor che supporti la sintassi evidenziata per il C (la maggior parte degli editor ha questa funzione). E assieme al vostro editor preferito fate uso di un terminale per scrivere qualche comando. Quando avrete padroneggiato questi passi e, capito cosa succede sotto il cofano, potrete ancora passare ad un IDE, oppure no. Io scrivo tutto il mio codice utilizzando Emacs e qualche x-terminals.

  

  Hello World

  

  Abbiamo parlato abbastanza. La più semplice applicazione (che in effetti faccia qualcosa), e di fatto il primo esempio per ogni linguaggio di programmazione, è l'applicazione nota come "hello world" (ciao mondo). È un'applicazione che si avvia, visualizza la stringa "Hello World (Ciao Mondo)" e termina. Il codice può essere visto nel Listato 1. Per compilare ed eseguire questa applicazione, mettetelo in un file di testo con estensione .c, aprite un terminale, andate nella cartella dove avete salvato il file ed eseguite:


  
    01. #include <stdio.h>

    02.

    03. /***********************************

    04. * Main function gets called when *

    05. * the application is launched *

    06. ***********************************/

    07. int main()

    08. {

    09.  // Say something to the audience

    10.  printf("Hello world\n");

    11.  return 0;

    12. }

    

    Listing 1
  


  Per compilare ed eseguire questa applicazione, mettetelo in un file di testo con estensione .c, aprite un terminale, andate nella cartella dove avete salvato il file ed eseguite:

  

  gcc -Wall -W -Werror hello-world.c -o hello-world

  ./hello-world

  

  Hello world

  echo $?

  

  0

  

  La prima linea invoca il compilatore GNU C per compilare il file chiamato hello-world.c e lo restituisce in output (-o) come eseguibile chiamato hello-world. Le opzioni -Wall -W e -Werror comunicano al compilatore di verificare i warning (un warning è un errore non critico, significa che la compilazione avrà successo ma che il programma potrebbe non produrre, in tutte le situazioni, ciò che l'utente si aspetta) e interrompersi quando ci si imbatte in un uno di essi. Eseguiamo il file binario aggiungendo all'inizio "./", questo perché la cartella dove piazzate gli eseguibili di solito non è inclusa nel vostro $PATH. E utilizzeremo il bizzarro comando echo per avvisarci dell'exit status (codice di ritorno) dell'ultimo comando eseguito. Non è una coincidenza che questo valore sia lo stesso dell'istruzione "return".

  

  • La prima riga è per il precompilatore. È un'azione eseguita prima della compilazione e si occupa di manipolare il linguaggio C, collegando altri file o sostituendo le macro con il codice C. Ingloba un file header chiamato stdio.h. Questo file dovrebbe trovarsi in /usr/include/stdio.h e contiene le definizioni di diverse funzioni; nel nostro caso ci serve per far sapere al compilatore che qualcosa chiamato printf() esiste.


  • Le righe 3-6 sono un blocco di commento che sarà ignorato dal compilatore, qualsiasi cosa tra "/*" e "*/" sarà ignorato. È chiaro che questo commento può dividersi su più righe.


  • La riga 7 definisce il punto d'entrata principale della nostra applicazione. Quando l'applicazione viene eseguita, inizierà eseguendo la funzione chiamata main(); l'int che la precede, indica che la funzione restituirà un intero. Le "()" indicano che main() è una funzione e che non prende argomenti (può prenderli, ma ne parleremo più avanti).


  • La riga 8 inizia un blocco che viene chiuso alla riga 12. Questi blocchi raggruppano gruppi di istruzioni; in questo caso il gruppo delle istruzioni della funzione main().


  • La riga 9 è un commento in singola linea. Quando in una riga si incontra un "//" il compilatore ignora il resto di quella riga. È impossibile interrompere questi commenti e non possono dividersi su più righe.


  • Dopo la riga 10 troviamo finalmente qualcosa di utile; qui invochiamo una funzione chiamata printf() e, tra parentesi, passiamo alla funzione un argomento che nel nostro caso è una stringa letterale. Le stringhe in C sono messe tra apici doppi. Così abbiamo chiamato la funzione printf() con una stringa come argomento. La sola cosa strana qui è "\n"; è una cosiddetta sequenza di escape e significa niente di più di una nuova linea. Provate a rimuoverla e vedrete che quando eseguite l'applicazione il prompt sarà visualizzato sulla stessa riga dell'applicazione. Notate che ogni istruzione termina con un punto e virgola. Vi dimenticherete di piazzare questi punti e virgola in numerose occasioni! In questo modo potete mettere più istruzioni su una stessa riga, oppure potete metterle su più righe.


  • La riga 11 fa uscire dalla funzione main e restituisce un determinato valore (in questo caso 0, che è di tipo int) a ciò che ha chiamato questa funzione. In questo caso la funzione main è stata chiamata dalla shell. Ecco perché echo $? ci restituisce uno zero. Anche questa è un'istruzione e va terminata con un punto e virgola.

  

  Una nota finale, se modificate il codice sorgente dovete eseguire nuovamente gcc. Il C non è come Perl, Bash, Python, PHP e altri, non è un linguaggio interpretato; il comando gcc chiama un compilatore (che trasforma un linguaggio di alto livello in assembler), un assemblatore traduce l'assembler in file oggetto (istruzioni macchina) e un linker unisce i vari file oggetto in un file eseguibile. Tutto questo traduce il codice C in codice macchina che la vostra CPU è in grado di capire ed eseguire.

  

  Esercizi


  • Compila da solo l'esempio, verifica di poter riprodurre il risultato.


  • Fa visualizzare all'applicazione "Hello Ubuntu".


  • Rimpiazza return 0; con return 1; e verifica che lo stato di uscita è cambiato.


  • Cancella l'istruzione return 1; e verifica cosa dice il compilatore. È un warning o un errore?


  • Esegui gcc senza il parametro -Werror; crea il binario o no?


  • Rimuovi il parametro -o hello-world. Qual è il nome di default dato al binario? La risposta è sotto.


  • Prova a rimuovere tutti i commenti dal codice sorgente, verifica che non ci sono effetti.


  • Se rinomini la funzione main() in foo(), cosa dice il compilatore (in verità il linker)?

  

  Risposta: il nome di default è a.out

  

  Elie De Brauwer è un belga patito di Linux, attualmente impiegato come ingegnere di software embedded con una delle compagnie leader nelle comunicazioni satellitari. Quando non passa il tempo con la sua famiglia, ama giocare con la tecnologia e passare i suoi giorni aspettando la release di Diablo III.


  

  



  How To

  Connettersi a IRC


  Scritto da Chris Lucier


  Internet Relay Chat (IRC) è un modo di comunicare online, in tempo reale, con altri utenti raggruppati in reti. Le reti hanno vari canali in cui gli utenti si possono incontrare. All'interno di un canale potete comunicare con gli altri e anche spedire file. Questo tutorial è una semplice guida per iniziare a utilizzare IRC con le applicazioni XChat (GNOME) e Konversation (KDE).

  

  Sia XChat che Konversation sono disponibili attraverso i repository standard di Ubuntu. Per installarli, utilizzate un qualsiasi gestore di pacchetti con cui vi trovate bene. Per Xchat vi verrà suggerito d'installare sia xchat che xchat-common (se per qualche ragione ciò non succedesse, assicuratevi di selezionarli entrambi). Inoltre, fate attenzione a installare xchat e non xchat-gnome, altrimenti questo tutorial non funzionerà.
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  Quando parte Xchat, vi sarà presentata una Lista delle Reti. Create qui il vostro nome utente e un nome alternativo (nel caso il vostro sia già stato preso da qualcun altro). Opzionalmente potrete inserire il vostro vero nome.
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  In Konversation vi verrà presentata una lista di Server, al cui interno sarà presente una sola voce che vi porterà al canale IRC di Kubuntu. Fate clic su “Nuovo”, quindi su “Modifica”, inserite alcune informazioni sull'identità Predefinita e premete su “OK”.
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  Vogliamo collegarci alla rete di FreeNode dove troveremo il canale di Full Circle. Per fare questo in Xchat, nella lista delle Reti fate clic su “FreeNode”.
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  In Konversation dovremo aggiungere FreeNode alla nostra lista dei server IRC, facendo clic sul bottone “Nuovo” nella finestra della lista dei Server e inserendo “FreeNode” come nome della Rete. Successivamente fate clic sul bottone “Aggiungi”. Per il Server inserite irc.freenode.net e come porta inserite la 6667. Quindi fate clic su “OK”.

  

  Successivamente, in Xchat, inseriamo il nome del canale, che è #fullcirclemagazine.
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  Potete anche vedere la lista di tutti i canali disponibili all'interno del server ma, per ora, ci atterremo a ciò che conosciamo.
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  Allo stesso modo, nella finestra della “Nuova rete”, in Konversation, fate clic sul bottone “Aggiungi” sotto “Entra nei canali automaticamente”, inserite #fullcirclemagazine e fate clic “OK”.
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  Per connettersi al canale IRC di Full Circle, in Konversation, fate clic su FreeNode e, poi, su “Connetti”.

  

  In Xchat vedrete dei testi di benvenuto al canale FCM con una lista di utenti, sulla destra, che sono già presenti. Konversation utilizza un'interfaccia a schede: fate allora clic sul tab di #fullcirclemagazine per vedere il canale chat.
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  Qui adesso potrete parlare con chiunque di qualsiasi cosa desideriate. Se il vostro argomento non è trattato nel canale in cui siete, potete andare sul menu e selezionare “Server” > “Entra nel Canale” (in Xchat) o “File” > “Entra nel Canale” (in Konversation), per trovare un altro canale dalla lista. Dovreste vedere il vostro nickname in basso nella finestra vicino a un riquadro. Questo box è il luogo dove inserire cosa volete dire e ogni comando di cui avrete bisogno.

  

  Un servizio IRC veramente molto utile di cui fare uso è NickServ. Esso vi permette di registrare il vostro nickname e di proteggerlo con una password. Potete anche collegarlo al vostro indirizzo email. Questo previene l'utilizzo del vostro nome da parte di altre persone.

  

  Per definire il vostro nickname, utilizzando il servizio NickServ, aprite Xchat (o sul vostro client IRC scelto) e inserite:

  

  /msg NickServ REGISTER your_password your_email
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  Se tutto si è svolto correttamente, dovreste vedere qualcosa di simile all'immagine sopra riportata. Riceverete anche un'email con una password per finire la registrazione del vostro nickname. Ricordatevi che le password fanno distinzione fra maiuscole e minuscole!

  

  Questa non è la sola funzione di NickServ. Non mi addentrerò in ulteriori dettagli in questo articolo, ma potrete trovare più informazioni in http://www.technerd.net/nickserv.html

  

  Per chiacchierare in un canale IRC, dovrete solamente digitare ciò che volete dire e premere “Invio”, come fareste in un'applicazione di messaggi istantanei. Potete anche eseguire funzioni speciali utilizzando i comandi. Giusto per iniziare, riporto qui un po' di comandi utili e cosa fanno:

  

  /me <type your message/action>
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  /nick <new nickname>
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  Per spedire un messaggio privato a un utente, utilizzate il comando “/msg” seguito dal nick dell'utente con cui desiderate colloquiare, quindi digitate ciò che volete dire, in questo modo:

  

  /msg deicidist Hi deicidist! Can you help me with something?


  [image: ]


  Notate che, per spedire messaggi privati su freenode, dovrete registrare il vostro nick ed essere identificati da NickServ (guardate sotto per come farlo automaticamente). Se avete bisogno di aiuto, potete utilizzare il comando “/help” per ottenere una lista dei comandi utili da usare nella vostra sessione IRC. Vi basta digitare “/help” e premete invio.

  

  Quando avete intenzione di uscire, potete spedire un messaggio di saluto a tutti utilizzando il comando “/quit.

  

  /quit Bye everyone!
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  Xchat vi offre l'opzione di entrare automaticamente nel vostro canale preferito. Per questo esempio, continueremo a utilizzare il canale di Full Circle. Fate clic sulla rete FreeNode e poi su “Modifica”. Quindi selezionate il box “Connetti automaticamente a questa rete all'avvio” e digitate #fullcirclemagazine nel box “Canali nei quali entrare”. Potreste anche voler compilare il box della password del NickServ, nel caso vogliate utilizzare il vostro nickname registrato sul canale quando siete entrati. Di contro, in Konversation, tutto ciò lo abbiamo già fatto nella finestra “nuova rete”.

  

  Fate clic su “Chiudi”. Dovreste ritrovarvi nella finestra della lista delle reti. Potreste anche selezionare il riquadro “Salta lista reti all'avvio”, se vi aggrada. Questo vi permetterà di entrare direttamente nel canale selezionato per la connessione automatica, senza essere interrotti da questa finestra. Fate clic su “Connetti” quando siete pronti. Ora, ogni volta che farete partire Xchat, sarete inviati direttamente nel canale Full Circle nel quale avete registrato il vostro nickname!

  

  Nel caso incontriate qualche problema, sentitevi liberi di chiedere aiuto nel forum di Full Circle all'interno dei forum Ubuntu: (http://ubuntuforums.org/forumdisplay.php?f=270). Mi potete trovare utilizzando il nome deicidist sui forum, oppure nel canale IRC di Full Circle. Ci vediamo lì!

  

  Chris Lucier è un libero professionista dell'IT e consulente di computer che ha come alias chris.lucier e deicidist su molti forum. Svolge tutto il suo lavoro su un ASUS Eee PC 701 (4G) e usa Ubuntu dalla versione 6.06.


  

  



  How To

  Usare GIMP - Parte 6


  Scritto da Ronnie Tucker


  Questo mese proseguiamo con alcune funzionalità avanzate di GIMP. Questo gruppo di funzioni è usato principalmente per ritocchi fotografici (noti anche come air-brushing) sia per correggere, sia per migliorare un'immagine.

  

  Cominciamo con un semplice fotoritocco: i maledetti occhi rossi. Questi appaiono quando il flash della macchina fotografica illumina l'interno del bulbo oculare, facendo apparire la pupilla rossa anziché nera.
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  Il modo più semplice per correggere gli occhi rossi è andare nel menu Filters > Enhance > Red-Eye Removal. Questo vi darà un'anteprima dell'immagine e un controllo per ottimizzare la rimozione degli occhi rossi.
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  Ma aspettate, sta modificando parti dell'immagine che non sono le pupille! Questo perché anche le labbra sono rosse. In realtà, tutto quello che GIMP sta facendo è cambiare i pixel rossi in neri. Quindi dobbiamo essere più selettivi con questa immagine. Utilizzate lo strumento di selezione rettangolare per disegnare un riquadro attorno ad entrambi gli occhi, quindi provate il filtro “Rimozione occhi rossi”.
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  Molto meglio. Solo state attenti di non esagerare con le funzioni di controllo, scurireste le sue sopracciglia rossicce.
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  Un altro modo per rimuovere gli occhi rossi è quello di creare semplicemente un altro livello, disegnare dei punti neri per ogni pupilla e quindi moltiplicare il livello coi punti per l'immagine originale finché non appare sistemata. Ma il filtro “Rimozione occhi rossi” è una scorciatoia veloce e carina.
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  Il nostro prossimo volontario è una celebrità che, in questa foto, appare un po' diciamo "consumata dall'uso". Aiutiamola: ha bisogno di togliere quelle orrende macchie.


  Lo strumento “Healing” [image: ](cura ndt) vi permetterà di scegliere un punto (nessun gioco di parole voluto!) nell'immagine come riferimento. GIMP quindi cercherà di rendere uguale quello che finisce sotto il vostro pennello, tenendo conto del punto di riferimento. Prima selezionate l'icona dello strumento Healing. Vedrete due cerotti incrociati vicino al vostro puntatore con un simbolo "accesso vietato" (un cerchio con una linea diagonale che lo attraversa). Questo significa che non avete ancora definito un punto di riferimento. Tenete premuto CTRL e il simbolo "accesso vietato" svanirà. Selezionate qualche parte vicino alla macchia e quindi rilasciate CTRL. Vedrete ora un cerchio con una croce all'interno a marcare il punto di riferimento.
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  Ora, semplicemente disegnate sopra la macchia vicina e, se il punto di riferimento è buono, la macchia svanirà. A volte avrete bisogno di annullare quello che avete fatto con lo strumento Healing e riprovare, ma provare e sbagliare non fa mai male.

  

  E, come qualsiasi buona crema per rimuovere i punti neri: applicate al bisogno!
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  Adesso la nostra celebrità è pronta per la copertina.
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  Prima di iniziare a indicarmi, no, non sono io nella foto! É mio nonno e la foto fu scattata nel 1930, circa, quindi è un po' malandata e ha bisogno di qualche ritocco.

  

  Per questo potremmo utilizzare facilmente lo strumento Healing, ma, questa volta, introdurremo il potente strumento Clone [image: ]. Avrà bisogno, come lo strumento Healing, di un punto di riferimento, ma questa volta clonerà semplicemente il punto di riferimento dove metterete il pennello, nessun lavoro di confronto. Quindi proviamolo: stessa idea, selezionate lo strumento Clone, tenete premuto CTRL, selezionate la sorgente (vicino ad uno strappo nella foto), rilasciate CTRL e siete pronti a rimuovere i danni.
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  E, giusto per dimostrazione, provate lo strumento Healing su alcuni strappi della foto. Probabilmente funzionerà allo stesso modo, ma è sempre meglio avere un piano B!

  

  Il prossimo mese approfondiremo i filtri, ombreggiature, sfocature, sbavature e tutte le importanti maschere di livello.

  

  Ronnie Tucker è editore di Full Circle magazine, utilizzatore orgoglioso di Kubuntu e artista part-time la cui galleria di lavori può essere vista su www.RonnieTucker.co.uk.


  

  



  How To

  Scansionare e convertire in PDF


  Scritto da Irv Risch


  Il mio problema era riuscire a mettere su Internet una vecchia newsletter in formato PDF, ma l'unica cosa che avevo era una copia cartacea. Ho provato a farlo su una macchina con installato Windows, ma dopo qualche tentativo ho desistito e ho avviato il mio portatile con Linux

  

  La prima cosa che dovevo fare era collegare il mio scanner con il portatile. Nessun problema, ha riconosciuto la periferica perfettamente.

  

  A questo punto mi piacerebbe potervi dire che potete effettuare le scansioni direttamente da OpenOffice Writer, ma ho avuto problemi con il loro “Seleziona la sorgente di scansione”. Tutto è in millimetri anziché pollici e le uniche opzioni per il DPI sono 50 o 1200, per cui agiamo in maniera leggermente differente. Avrete bisogno dell'applicazione “Xsane”, presente nei Repository. Se non lo avete installato, fatelo come prima cosa. Andate nel pannello dei menu e selezionate Applicazioni > Grafica > Xsane  Scanner di immagini. L'ho impostato in modo da fargli aprire quattro finestre.
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  1.Finestra principale Xsane (sinistra)

  2.Finestra degli istogrammi (in alto al centro)

  3.Finestra delle opzioni (in basso)

  4.Finestra dell'anteprima (destra)
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  Nella finestra principale ho impostato il percorso, il tipo di file (JPEG) e la risoluzione (300). Ho lasciato tutte le altre impostazioni quelle predefinite.
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  Nella finestra dell'anteprima, ho impostato la scansione a tutta pagina e lanciato l'acquisizione dell'anteprima.

  

  Dopo aver ottenuto l'anteprima (cliccando su “Acquisisci anteprima”), selezionate l'area da scannerizzare spostando i righelli nella finestra dell'anteprima (osservate la linea tratteggiata attorno all'immagine scansionata nella figura in alto), quindi andate nella finestra principale e cliccate sul pulsante Scansione.
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  Quando la scansione è stata ottenuta, si aprirà la finestra del visualizzatore di immagini che illustra il risultato finale.
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  Adesso bisogna salvare la scansione andando nel menu File > Salva immagine.
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  Se usate il nome file impostato come predefinito, salverà le scansioni come pagina0001, pagina0002, ecc. Nel mio caso, avevo bisogno di realizzare 4 scansioni. Non appena ho finito, mi è bastato chiudere il visualizzatore di immagini e la finestra principale, che le altre finestre sono sparite automaticamente.

  

  Adesso vediamo come fare per convertirle in un bel documento in formato PDF. Aprite OpenOffice.org Writer dal vosto menu Applicazioni. Si aprirà con un documento vuoto.
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  Con il puntatore andate al di sopra della prima pagina e selezionate il menu: Inserisci > Immagine > Da file...

  

  Selezionate il file che volete inserire e cliccate su Apri.

  

  Posizionando poi il cursore all'inizio della pagina seguente, ripetete l'operazione finché non avrete tutte le scansioni effettuate nel vostro documento OpenOffice. Dopo di ciò, vogliamo esportare il tutto in formato PDF.

  

  Possiamo farlo andando nel menu: File > Esporta nel formato PDF.
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  Non appena si apre la nuova finestra, lasciate tutto impostato come predefinito e selezionate il pulsante “Esporta”.

  

  Si aprirà la finestra per il salvataggio del documento, dove potete scegliere dove salvare il documento realizzato. Verrà salvato come documento formattato in PDF.
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  Dopo aver chiuso il vostro documento in OpenOffice Writer, potete lanciare un'anteprima del lavoro finito. Andate dove avete salvato il vostro file e apritelo con il vostro visualizzatore di documenti in PDF.
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  Ecco come il mio documento finito viene visualizzato con KPDF.

  

  Per terminare il mio lavoro, ho aperto Firefox, selezionato il plugin FireFTP e ho caricato il file sul mio server Web. Se volete vederlo, lo potete trovare all'indirizzo: http://wabasha-server.net/Outlook.pdf.


  



  Scrivi per Full Circle


  Linee guida


  La regola generale per un artico è che deve essere collegato ad Ubuntu o alle derivate - Kubuntu, Xubuntu,Lubuntu, etc.

  Scrivi un articolo sul software che preferisci -suggerisco LibreOffice ma, si prega di controllare la grammatica e l'ortografia


  la guida ufficiale sullo stile di Full Circle Magazzine può essere letta su:


  http://url.fullcirclemagazine.org/75d471


  Si prega di leggere il presente documento prima di inviare un articolo. Seguite le istruzioni e avrete molte più possibilità di vedere il vostro articolo in Full Circle.


  Scrittura


  Non vi è alcun limite di parola per gli articoli, ma sappiate che gli articoli lunghi possono essere suddivisi tra diverse edizioni. Nel vostro articolo, vi preghiamo di indicare se si desidera inserire una particolare immagine . Si prega di non utilizzare alcuna formattazione nel documento.


  Immagini


  Le immagini non devono essere più di 800 pixel di lato, in formato JPG, esi prega di utilizzare la compressione bassa.


  Quando si è pronti per inviare il proprio articolo potete scriverlo a: articles@fullcirclemagazine.org


  Scrittori non inglesi


  Se la vostra lingua madre non è l'inglese, non vi preoccupate. Scrivete il vostro articolo, e uno dei correttori di bozze lo leggerà per voi e correggerà eventuali errori grammaticali o di ortografia. Non solo state aiutando la rivista e la comunità, ma state aiutando anche il vostro inglese!


  RECENSIONI


  Giochi/applicazioni


  Quando fate una recenzione per un gioco o un'applicazione indicare chiaramente


  
    	Titolo del gioco


    	Chi sviluppa il gioco


    	Se il download è free o a pagamento


    	Dove reperire il gioco (indicate il download/homepage/url)


    	Se è nativo per linux o si deve usare wine


    	Il tuo voto da 0 a 5


    	Un indice- con punti positivi e negativi

  


  Hardware


  Se recensite Hardware per favore indicare:


  
    	Marca e modello dell' Hardware


    	In quale categoria inserire l'hardware


    	Eventuali difetti che hai notato durante l'utilizzo dell'Hardware


    	Se l'hardware lavora facilmente con Linux?


    	Hai usato drive di windows?


    	Il tuo voto da 0 a 5


    	Un indice- con punti positivi e negativi

  


  Non è necessario essere un esperto per scrivere un articolo - scrivete su applicazioni, giochi e l'hardware che si usano tutti i giorni.


  



  La mia storia

  ...Quando ho compiuto due anni


  Scritto da David Rowell


  Sono un settantunenne ingegnere meccanico aeronautico, pensionato, originario del centro di New York ed ora vivo in Florida sulla "Costa Spaziale". Per darvi un'idea della mia età, Hitler invase la Polonia quando avevo due anni. Gli anni dal 1956 al 1959 li ho trascorsi in Germania con il 14mo Cavalleria pattugliando i confini. Mi sono diplomato in fisica nel programma AA al Sierra College e nel BA alla Università di Syracuse.
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  La mia prima esperienza con i computer è stato un corso di programmazione FORTRAN alla SU nel 1965. Perforavamo le nostre schede (in alto a destra) e quindi offrivamo il mazzo ai maghi dei computer, sperando di essere benedetti con qualche risultato interessante. Avete mai considerato cosa accade quando si inseriva un mazzo di scheda perforate? Nel 1967, la Hewlett Packard mi invitò a Paolo Alto per un paio di settimane per studiare l'HP-2116, un computer destinato ad essere utilizzato in ambito industriale o di laboratorio. Al lavoro, accedere al GE Timesharing System utilizzando una macchina telescrivente ASR-33 era un'opportunità per programmare utilizzando un set di comandi BASIC veramente molto potenti. Con queste risorse abbiamo potuto sviluppare gli strumenti che hanno costituito la spina dorsale del lavoro dell'ingegnere, risparmiando tempo e rendendo più semplici le ottimizzazioni.
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  Intorno al 1970, Lipe Cluthc stava progettando un nuovo impianto per i test equipaggiato con un motore d'aereo con più di 1000 cavalli. Per gestire il sequenziamento corretto e gli aspetti della sicurezza, installammo un computer HP 2100 mini (a destra) per controllarlo. Il nostro avanzatissimo 2100 aveva 8k RAM , un perforatore da 75 c/s e un lettore da 300 c/s e un buon vecchio terminale ASR-33. Programmavamo in BASIC, Algol e in FORTRAN e per i driver delle periferiche utilizzavamo l'assembler.
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  Nei primi anni 80 comprai ai miei figli un Commodor VIC 20. I motivi? Poteva essere espanso, era disponibile un assembler, aveva un BASIC decente e potevamo permettercelo. I ragazzi spiegarono agli insegnanti come usarlo e furono esclusi dai corsi! Il VIC (sopra) fu seguito da un paio di C-64 e da un C-128 (sotto).
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  Altri tempi, oramai l'abbiamo dato via, ma ricordo che abbiamo speso più di $ 1000 nell'ampliamento completo del VIC. All'età di 14 anni mio figlio scrisse l'F79 Forh system per la CPU MOS 6502 del VIC e io sviluppai strumenti per applicativi d'ingegneria.
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  Nell'84 acquistai un TRS-80 Model 100 (sopra) il primo computer portatile di successo al mondo. L'M100 aveva molte caratteristiche interessanti: 32k di RAM, CPU a 2.4 MHz 80C85, uno slot per la ROM, porte per una stampante vera e seriali ma, più di tutto, aveva un modem integrato. Uau! Potevo accedere a CompuServe a 300 baud! Potevamo scambiare idee e codice con altra gente di tutto il mondo, persone che non avevamo mai visto né avremmo voluto vedere. Presto aggiunsi al suo interno una SuperROM e ebbi un programma di video scrittura, foglio di calcolo e un processore per le presentazioni. Oh, vi ho detto che rimaneva acceso per settimane con 4 pile AA? Ho sviluppato il FIG Forth system e ho scritto alcuni articoli per riviste sull'M100. Il mio software per le turbine migliorò incredibilmente le prestazioni con il BASIC più potente. Nel 1984 l'Apple MAC fu presentato ovunque durante gli incontri dei gruppi di utenti del FORTH. Wow, una vera grafica e la meraviglia di far succedere cose con un mouse. Uno dei membri fece vedere quanto fosse stressata la CPU 68000 con il porting del FORTH system. Andava come una lumaca e il Forth semplicemente non lo faceva! Mio figlio comprò un Atari ST nell'85 o nell'86. Prima che arrivasse a casa era stato modificato con 1MB di RAM, saldata con attenzione sulla main board. Ora stiamo parlando di grafica a colori, di mouse e di una velocità decente. Lo portò con sé al college dove morì in un bagno di birra!

  

  The Commodores were followed by a succession of PCs of one sort or another, most home made (I like ASUS motherboards). If you haven't worked with CP/M, or one of the other early operating systems, it is hard to appreciate the immediate impact of DOS and the IBM PC. Even DOS 1 was far more forgiving than CP/M. DOS 2 was much more powerful than any alternatives. DOS, combined with open hardware architecture, was just what the business owner needed, and the blower application software just got better.
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  I Commodore sono stati seguita da una successione di PC di un tipo o di un altro, la maggior parte dei quali fatti in casa (mi piacciono le schede madri ASUS). Se non avete mai lavorato con CP/M o un altro dei primi sistemi operativi, farete fatica ad apprezzare l'immediato impatto del DOS e dell'IBM PC. Anche se il DOS 1 è stato molto più indulgente del CP/M. DOS 2 era molto più potente di qualunque altra alternativa. Il DOS, affiancato da un'architettura hardware aperta, è stata esattamente quello di cui un imprenditore aveva bisogno, e il software applicativo per le turbine girava semplicemente meglio. Ho provato Windows 2 (sopra) per una settimana o giù di lì su una mia macchina 80386, lento, goffo veramente un accrocchio! D'altro canto Windows 3.1 era il reale vincitore. Quando il prezzo di un hard disk da 40Mb scese sotto i 400 $ io e mio figlio convincemmo la mamma che ne avevamo bisogno e dopo averlo usato qualche giorno fu d'accordo anche lei! Tenete a mente che un disco da 40MB era un disco così grande che doveva essere partizionato in due per poter soddisfare il limite di 32MB del DOS/Windows. Presto, avremmo preso un lettore CD e una scheda Sound Blaster ad un prezzo simile, trovandoci così in un mondo "moderno". I nostri giochi che, fino ad allora, erano stati dominati da Zork e simili, ora potevano avere grafica e sonoro! Potevamo udire Kings Quest!
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  A un certo punto del '94 IBM rilasciò una meravigliosa demo del OS/2 Warp (sotto) al Syracuse PCUG. Per la prima volta vedevamo il Word Wide Web! Oh, lo stupore di vedere foto dal Louvre e da altri posti meravigliosi! Volevamo solo averlo e il prezzo speciale lo rese alla nostra portata. Sì, era un Windows migliore di Windows. Sì, eseguiva programmi DOS come o addirittura meglio di Windows. No, non gli piaceva la mia stampante. Sì, era lento ma accidenti come era bello.

  

  Riscrissi il codice di un programma per l'analisi dei compressori centrifughi della NASA utilizzando il Professional BASIC e non avevamo un compilatore FORTRAN al lavoro. Sul mio Windows 3 con processore 80386/387 a 10 MHz, potevo far partire l'analisi di un caso semplice, andare a preparare una brocca di caffè, tornare indietro con una tazza solitamente prima che l'esecuzione fosse terminata. Su questa macchina aveva terminato appena il mio dito rilasciava il tasto Invio!

  

  Ho tentato con svariate distribuzioni Linux da Red Hat a Mandrake alla fine degli anni 90. Si installavano e io ci mettevo un po' a far funzionare l'audio e il mio drive ZIP. Ma l'usabilità era nulla se non per l'uso dello zip, così ritornai al DOS e a Windows.

  

  Su suggerimento di mio nipote installai Ubuntu 5.04 in dual boot con XP sul mio pc Compaq AMD Athlon XP. Mi piacque quello che vidi e fui deciso a imparare e a vivere con Linux poiché non ero interessato per nulla le prossime versioni di Windows.

  

  Avevo pubblicato questo post alcuni anni addietro: "Fino a che le applicazioni grafiche non cambieranno radicalmente non potrò usare esclusivamente Linux: non mi viene offerto un buon programma CAD 2d/3d per sostituire CADKEY che uso ora. Non trovo un programma di genealogia buono come quello che adopero ora (ho provato GRAMPS ed è buono ma non quanto PAF5 o Ancestral Quest). Scrivo e utilizzo il software di disegno in MS Professional BASIC (che gira bene sotto XP) e non trovo un buon sostituto in Linux (Sì, ho scritto un po' di applicazioni in gcc a girano bene ma non ho veramente voglia di convertire tutto). Penso che GIMP possa fare tutto quello che Paint Shop Pro farà, devo lavorarci. Tutti i miei CD sono online sotto forma di file MP3; riconvertirli tutti sarebbe un inferno. Non sono sicuro di come si vedano o modifichino filmati sotto Linux."
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  Poco dopo la pubblicazione del mio post, Wine fece passi da gigante, permettendomi di eseguire il sistema CAD e il programma di genealogia. Ho scoperto DOSBox e si sposa perfettamente con Professional BASIC. Sto lentamente imparando ad utilizzare GIMP e sì farò tutto quello che deve essere fatto. E i recenti articoli su Full Circle Magazine di sicuro aiutano. Ho scoperto i CODEC "malvagi" che risolvono i problemi degli MP3 e dei video. GRAMPS (sopra) ha avuto un aggiornamento importate e più recentemente un altro ancora; ora vince a man bassa. Qualcuno mi ha suggerito Avidemux come editor di filmati. Soddisfa le mie necessità. Update Manager è specificatemene indicato per mantenere il sistema e le applicazioni aggiornate, aggiornate poco alla volta piuttosto che con un unico enorme "service pack" che smette di far funzionare così tante applicazioni. Dunque sono felice come una pasqua con Ubuntu: è stabile ed ho trovato il software di cui avevo bisogno.

  

  Attualmente, Ubuntu Hardy Heron mi appaga pienamente. Oh il mio Windows XP è aggiornato al SP3 ma non lo uso tranne che per gestire il mio iRiver T-10. Un giorno mi preoccuperò di come maneggiarlo sotto Ubuntu.

  

  Ho avuto l'opportunità di sviluppare e testare alcune turbine centrifughe per Hoffman Air Systems. Con il mio attuale progetto (un post bruciatore) stiamo cercando di scrivere un manuale per lo sviluppo delle turbine centrifughe ma non andremo mai oltre la prima bozza! Certo, il software di sviluppo delle turbine utilizza gli strumenti Fortran per Linux e utilizziamo Open Office per la scrittura. Quando ne ho bisogno, il mio vecchio sistema in MS Professional BASIC viene correttamente eseguito attraverso DOSBOX mentre il software CAD viene eseguito con Wine.

  

  Sono diventato lo storico di famiglia da quando mia figlia mi ha gentilmente chiesto di "aiutarla". Per organizzare i dati della nostra famiglia abbiamo usato Family Tree Maker per un po' ma poi abbiamo optato per Personal Ancestral File. La base dati di PAF è stata convertita un paio d'anni fa nel più potente software per Linux Gramps. L'anno scorso ho scannerizzato sette scatole di foto di famiglia e di documenti utilizzando XSane Image Scanner. Con GThumbs ho organizzato le mie foto, con GIMP le ho "migliorate" e unito più scansioni in un'immagine. Ho lavorato per riunire in un elenco i laureati all'accademia di Baldwinsville (NY) dal 1870 al 1926, includendo in molti casi anche le loro spose. Quel piccolo PDF creato con Open Office è nella biblioteca insieme ai sorgenti dei file. Ho scannerizzato la 50ma edizione dell'anniversario della Gazzetta di Baldwinsville del 1896 e la sto lentamente indicizzando. Se mai riuscirò a finire, affronterò l'edizione del 100mo anniversario.

  

  Faccio parte, come ufficiale manutentore, del gruppo locale di radioamatori che ha costruito un veicolo per le comunicazioni di emergenza veramente completo. Come aiuto alla spiegazione ai membri del funzionamento del veicolo ho scritto un manuale utilizzando OpenOffice Writer. Ho convinto il gruppo ad adottare OpenOffice come software standard, ora devo convertirli a Linux!

  

  Molti programmi per Windows vengono eseguiti con Wine, io sto imparando il codice Morse con il programma Koch Morse Trainer della G4FON (sotto), con il vecchio Print Artist realizzo cartoline e le carico online con Flickr Uploader, PAF e Ancestral Quest mi consentono di dare una mano alle community di geneaologia.
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  Ma non ci sono solo cose serie. Mi piace giocare a PySol o a Mahjong, mi piace ascoltare musica con Audacious (K.I.S.S.). Ho transcodificato tutti i miei CD in file Ogg Vorbis, nel dettaglio penso che sia il formato con la miglior qualità audio. Planet Penguin Races permette ai vecchi Tux di divertirsi ancora e ancora. Frozen Bubble è divertente ma mi sono stufato e ho smesso di giocare intorno al livello 20.

  

  In famiglia, da quando abbiamo comprato il VIC-20 nei primi anni 80, abbiamo avuto qualcosa come 19 computer, inclusi 6 portatili. Oggi abbiamo un Compaq AMD Athlon XP con Windows XP e Ubuntu, un Asus EeePC con un meraviglioso Xandros Linux, un portatile Compaq con 98 seconda edizione e un portatile Toshiba con ME e Arch Linux con ambiente grafico Xfce. Ci sono un sacco di cose belle da dire su Xfce, soprattutto su hardware datato.


  

  



  La mia opinione

  E' questo l'anno?


  Scritto da Robin Catling


  Bios: check (controllo, ndt)

  

  Memory: check

  

  Realtà: check?

  

  "Crisi finanziaria!", esclamò improvvisamente Alter.

  

  "Che cosa?", dissi io mettendo giù il mio pasticcino.

  

  "Diritto di concessione!"; Alter lo stava chiaramente perdendo.

  

  "È una qualche sorta di gioco di parole? Dovrei forse unire le frasi insieme in una più lunga e meno significativa?"

  

  "Consideri, Professore, che questo potrebbe essere nella miglior prospettiva l'anno di Linux."

  

  Avreste potuto sentire il coro celeste nella sua testa appena lo disse. Abbiamo discusso di tale argomento ogni anno per gli ultimi dieci anni. Ogni volta Alter innalza le barricate della rivoluzione di Linux, pensando di resistere "all'autorità". Ancora non ho capito chi sia "l'autorità".

  

  "Ci pensi, Professore. Con tutti che tirano la cinghia"

  

  "I soldi sono troppo difficili da menzionare..." Mormorai, fuori luogo. Alter mi ignorò.

  

  "... nessuno vuole spendere soldi su un upgrade di Vista."

  

  "Non c'è stata esattamente una corsa prima della crisi finanziaria", dissi sarcasticamente.

  

  "Il vostro prestito non è un sub-prime, Professore." Questa frase era pesante, detta da un inquilino che non paga alcun affitto.

  

  "Comunque, la gente non sta comprando Vista perché sta tenendo XP."

  

  Alter assunse la posa con un sopracciglio alzato da condiscendenza. È la sua smorfia da compiacimento.

  

  "Penso che ci sia qualche milione di utenti di computer che sarebbero in disaccordo con lei, Professore."

  

  "Nominane centomila o giù di lì."

  

  "Tutte quelle persone che quest'anno hanno comprato dei computer net-book. Ci sono cinque milioni di PC Asus Eee, Acer Aspire, Elonex One, PC Everex Green, MSI Wind".

  

  Quando ha nominato Wind, ho fatto un chiasso puerile. Date la colpa a "Mezzogiorno e mezzo di fuoco".

  

  "Saranno cinque milioni di PC Asus Eee, ma solo due milioni hanno Linux."

  

  Alter non rimase impressionato, anzi era trasportato.

  

  "Dell vende Ubuntu con qualsiasi cosa. Questo è ciò che i consumatori vogliono."

  

  "Questo è ciò che i fan di Linux su Ideastorm volevano, non è la stessa cosa, Alter. Molta gente non si preoccupa. Questa è la ragione per cui il mio amico Steve B. di Redmond sta facendo affari tenendo XP operativo fin dopo l'età pensionabile."

  

  Non è realmente amico mio, l'ho incontrato solo una volta. Sono ancora parzialmente sordo dal mio orecchio sinistro.

  

  "Tu, tu!" farfugliò Alter. "Tu hai fatto quel podcast quest'anno, e lo hai anche chiamato È questo finalmente l'anno di Linux?"

  

  "L'ho fatto. Ho anche detto ...no, non lo è."

  

  "Il tuo ultimo cliente ha comprato dieci Asus Eee per valutazione, con il suo fondo cassa per le piccole spese."

  

  "Vero. Poi ne ha formattati molti per caricarci una versione personalizzata di XP."

  

  "Visibilità, Professore. Ci sono ancora milioni di desktop Linux, Xandros sull'Eee, che oscurano la cosa su Elonex. Tutti-basati-su-Linux!"

  

  Qualche volta Alter torna al suo vecchio Io marxista rivoluzionario. Lo sta toccando, davvero.

  

  "La gente sta cominciando a capire che non si ha bisogno di tutta quella massa di software per avere semplici funzioni desktop: email, navigazione web, videoscrittura. Tutti quei computer minuscoli ed economici sono l'avanguardia del carico Linux".

  

  "Hmmm. Posso vedere la quota del mercato dei desktop andare avanti. Forse di un'intera metà di punto percentuale. Purché l'India non compri computer questa settimana."

  

  "Ha!" Alter subdorava la vittoria. "India, Brasile, Cina. Avanti, Professore. Milioni di nuovi utenti nel mondo dello sviluppo e dell'hardware più economico di un Hum-Vee di seconda mano, hanno linux dappertutto, anche nei telefoni! I telefoni! Motorola ha già venduto nove milioni di telefonini basati su Linux."

  

  "Windows Mobile 6," considerai.

  

  "Gahhghgh," Alter era vicino al soffocamento.

  

  "Già. Ma sta diventando omnipresente, dai un'occhiata. Il mio attuale cliente è passato a quei telefoni HTC con Windows Mobile 6 e così hanno fatto i nostri principali fornitori. Il sistema operativo è distribuito con il telefono, non in un altro modo."

  

  Alter fece una pausa per respirare. Io pressavo.

  

  "Non osare menzionarmi quel terribile Android e quel Frappè Open", lo avvisai. "Software inutile, ecco cosa è; come un vino di basso costo. Non ne voglio senti parlare in casa, ti avverto".

  

  Me n'ero sbarazzato. Wellington poteva essere orgoglioso di me. Era l'ora del colpo di grazia.

  

  "Anche tenendo conto di tutti quei telefoni, tutti quei netbook, sai cosa succede quando chi ce li ha va a casa? Si siedono davanti ai loro PC e questi hanno ancora un logo di Redmond sullo schermo".

  

  Odiavo rovinare il suo fervore rivoluzionario, ma il vecchio ragazzo doveva capire che questa cosa di Linux è un lungo percorso. Schiacciato, Alter doveva ancora dire l'ultima parola.

  

  "Posso mettere un po' di veleno per topi nel suo pasticcino, Professore?"

  

  Robin Catling occasionalmente guadagna denaro come project manager, analista finanziario e istruttore tecnico. Insegna scherma a New Forest, Hampshire, Inghilterra, ed è completamente, e totalmente, matto.


  

  



  Recensione

  Linux Mint 5


  Scritto da Robin Catling
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    Anche se non è una delle distribuzioni ufficiali Ubuntu, quest’anno sulla rivista abbiamo dato abbastanza copertura a Mint: Mint 4.0 (Darya) è stato il "Meglio del mese" nel numero 10, ed è stata paragonata favorevolmente rispetto a Ubuntu nel numero 11. Adesso che è uscito il rilascio 5.0 (Elyssa), vale la pena dare un’altra rapida occhiata, in merito a 3 principi chiave:

    

    • è una cannonata negli aggiornamenti .


    • è ancora carina


    • è davvero, ma davvero facile



    Prima che diciate è solo un’altra distribuzione, tenete a mente l’hardware su cui l’ho fatta girare:

    

    • Compaq Deskpro, Pentium 3 733MHz, memoria 512mb, disco da 20Gb, scheda video integrata Intel.

    

    • Abit Pentium 4, 2.14GHz, memoria 1Gb, scheda video Geforce-IV AGP.

    

    • Entrambi provati con chiavetta wireless USB Belkin (in qualsiasi glossario Linux, chiavetta vuol dire problemi!).

    

    Elyssa alla menta fresca

    

    Mint 5.0 si basa su Ubuntu 8.04 Hardy, che vuol dire che tutto il codice sottostante, dal kernel alle utility alle applicazioni, è l'ultimo disponibile. Questo comprende il Desktop Gnome, OpenOffice e Firefox 3.
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      Il CD (Live) di Mint usa l’installer predefinito di Ubuntu. Seguendo i soliti passi, la procedura di installazione funziona perfettamente. Una volta configurato, il Mint Updater (sistema di aggiornamento, ndt) si collega ai repository Mint per scaricare gli ultimi aggiornamenti. Updater (a sinistra) mostra cosa c’è e valuta i pacchetti in una scala da 1 a 5, secondo l’importanza e la compatibilità. L'icona di Updater (un lucchetto, stranamente) risiede sul pannello Gnome.

      

      Elyssa, carina come una foto

      

      So che è un parere personale, ma, se non vi piace il marrone Ubuntu o il blu Kubuntu, allora il tema di Mint verde e nero è un piacevole cambiamento. Mint include anche i driver proprietari per schede grafiche Nvidia e ATI (gestiti da Envy), che funzionano bene. Pensavo che la grafica fosse abbastanza scadente sul mio vecchio computer Compaq, ma invece erano ben rifiniti e (senza effetti 3D) più veloci di quanto mi aspettassi. Se non vi pace il tema, il progetto Mint ha premurosamente fornito un segnalibro alla sua versione di gnome-look.org, pre filtrata per la distro Mint. Così, potete essere sicuri che tutti i vostri temi e funzioni lavorino su Elyssa.

      

      Il menu principale di Mint è esposto in maniera chiara, e non scoraggia i neofiti abituati al menu Start di Windows. Questo ci porta all’ultimo punto...

      

      Elyssa, si legge e-a-s-y (facile, ndt)

      

      Dopo due diverse installazioni su hardware vecchio, non ho avuto bisogno della riga di comando. Per me, questo è un grande trionfo, in quanto ho la mia chiavetta USB wireless funzionante senza nessun intervento. Il Pentium IV ha rilevato i driver Linux nativi e si è connesso al router al primo colpo. Il Compaq è stato un’altra storia. Ho avuto problemi a non finire con gli adattatori USB wireless, soprattutto perché legati all’uso di ndiswrapper con il driver Windows fornito con la chiavetta USB. Posso passare ore a smanettare sul terminale tentando di configurarli, e parlo di distro attuali. Ma non in Elyssa. Nel menu di Mint c’è una voce "Wireless Windows Drivers" (vedi sopra). Quando l’ho lanciato sul Compaq, ha suggerito quale driver usare per il chipset rilevato. Un clic per accettare, e il programma di installazione ha fatto tutto il resto da solo. Semplicemente funziona. Lo so che è solo un piccolo script ben fatto messo sopra la gestione reti di Ubuntu 8.04, ma questo è un bel cambiamento. Vi chiederete come mai non ce l’hanno tutte le distro Linux.
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        Mint ha già installati tutti i codec multimediali più comuni per la musica e il video. Se avete bisogno di software in più, il Mint Installer (voce "Software Portal" del menu Mint) vi offre una specie di ricerca alla Google per programmi particolari. Se trovati, vi porta su un sito web che elenca e descrive il pacchetto e ha il tasto "Install now" (installa adesso, ndt). Un clic scarica e installa il file giusto. Potreste dire "E allora?", ma secondo voi il principiante vuole rovistare tra i repository in Synaptic?

        

        Punti principali
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          Sorprendentemente, Mint sembra più veloce e scorrevole di una installazione Ubuntu sullo stesso hardware poco potente. Date Mint a un principiante Linux così non dovrete passare ore a spiegargli tutto. Il segnalibro Mint fornito su Firefox è un buon punto di partenza. I forum di Linux Mint sono un posto molto piacevole da visitare, secondi solo a Ubuntu. I neofiti si sentono ben accetti. Il Blog Mint e i bollettini informativi aggiornano regolarmente la comunità. Non rimpiazzerà ancora la mia installazione principale Ubuntu 8.04 (ho troppe personalizzazioni), ma Mint 5.0 Elyssa è una distro per il desktop usabile e pronta all’uso. Se la squadra di Mint continua a crescere di livello come sta facendo, tutte le altre distro ne dovranno tenere conto. E tutti noi ne trarremo vantaggio.


        

      

    

  


  Intervista ai MOTU - Harald Sitter


  Presa da motu.wordpress.com
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  Età: 19

  Luogo: Austria, Europe, Earth, Solar System, Milky Way, Universe

  Nick su IRC: apachelogger

  

  Da quanto tempo usi Linux e quale è stata la tua prima distro?

  

  Nel 2003 ho iniziato con Linux Red Hat 9, anche se non l'ho tenuta a lungo. L'ho sostituita presto con SUSE (la versione 9, credo), dove è iniziato il mo amore per KDE.

  

  Da quanto tempo stai usando Ubuntu?

  

  Da Breezy Badger, in dual boot con SUSE; dalla Dapper Drake, solo Ubuntu.

  

  Quando sei stato coinvolto nel gruppo MOTU e in che modo?

  

  Io penso sia stato quando ho pubblicato il mio primo pacchetto su kde-apps.org (anche se non credo sia stato incluso in Ubuntu). Successivamente a questo, Raphaël Pinson mi chiese se desiderassi contribuire a Ubuntu e mantenere lì il pacchetto. Mi sono unito alla tribù Kubuntu e ho iniziato a creare ulteriori pacchetti.

  

  Chi ti ha insegnato a pacchettizzare e come lavorano i gruppi Ubuntu?

  

  Ho creato il primo pacchetto seguendo gli howto su ubuntuforums.org; poi l'onnipotente wiki Ubuntu e la squadra Kubuntu (beh, anche un motore di ricerca molto noto).

  

  Quale aspetto ti piace del lavoro con i MOTU?

  

  Qualsiasi. Veramente, siccome ogni parte ha l'alto scopo di rendere più usabile (K)Ubuntu, mi piace veramente tutto. Tuttavia, suppongo, ciò che mi piace di più è introdurre software nuovo e importante per KDE/Qt e aiutare i nuovi partecipanti ad unirsi allo sviluppo di Ubuntu.

  

  Qualche consiglio per chi desidera aiutare i MOTU?

  

  Rivolgetevi a me. Come regola generale: non esitate a domandare.

  

  Hai già lavorato su molti pacchetti differenti nell'ultimo ciclo, cosa stai preparando per Hardy?

  

  Aggiornamenti, sponsorizzazioni e portare tutto il bellissimo software del nuovo KDE 4 su Universe. *muhahahaha*

  

  Pensi che Hardy sia speciale per i nostri utenti?

  

  Beh, Kubuntu Hardy sta per essere la prima versione con a bordo KDE 4.0. Ora lo sto usando di continuo sin da Novembre e posso dire onestamente che funziona bene, anche meglio di un pony! Allo stesso tempo, rilasciamo anche KDE 3.5.8: questo renderà Hardy molto imponente per due motivi: chi vuole provare la versione 4.0 lo potrà fare, e quindi riportare i bug e migliorare KDE 4.0.x che verrà inserito in Hardy+1; coloro che desiderano solamente un sistema stabile e affidabile, possono usare la 3.5.

  

  Frase preferita?

  

  Nulla è impossibile, se lo puoi immaginare.  Professore Hubert Farnsworth

  



  Che cosa fai nel tuo tempo libero?

  

  Gestione del marketing/ promozione, rilasci e qualunque altra cosa nel progetto Amarok, così come fornire supporto su Amarok, Kubuntu e KDE, e se rimane del tempo, dormire.


  

  



  Donne Ubuntu


  Scritto da Cathy Malmrose
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  Uno dei modi più efficaci per incoraggiare le donne ad unirsi a noi nell'ambiente Ubuntu è quello di rendere più accogliente e normale per le donne essere qui. Uno dei modi più validi per farlo è quello di amplificare le voci delle donne che sono già nel settore.

  

  Ci sono già molte donne di gran talento nel F/LOSS e tante si stanno specializzando in Ubuntu. Una delle prime donne che ho incontrato è stata Belinda Lopez. Mi ha subito dato il benvenuto e messo a mio agio. Ogni volta che la incontro a qualche conferenza lei mi presenta sempre gente nuova, tra cui anche Emma Jane Hogbin, una delle donne al centro di Ubuntu Women.

  

  Quest'anno ho avuto un mio stand alla LinuxWorld Expo 2008 di San Francisco. Ci sono state molte opportunità di parlare con Stormy Peters del progetto GNOME, attiva in passato per OpenLogic e HP. È una persona di grandi vedute e imparo sempre qualcosa di nuovo da lei. Ho di nuovo salutato velocemente Emily della Free Software Foundation. Ho incontrato per la prima volta una signora di nome Kit, che lavora con Angela Brown della Linux Foundation e si mostrò coraggiosa e carismatica.

  

  Di solito le conferenze sono eventi aziendali dove le aziende stanno fianco a fianco e gli stand sono tenuti da persone che potrebbero probabilmente non sapere molto dei prodotti che presentano. Di contro, molte conferenze su Linux generano una sorta di entusiasmo che mi invoglia a tornarci di anno in anno. C'è del cameratismo spontaneo agli eventi Linux, perfino a quelli grandi e imponenti come il LinuxWorld Expo. È facile attaccare bottone con chiunque lì perché si può essere relativamente sicuri che tutti condividono il nostro stesso amore per Linux. Si può anche stare certi che chiunque sia lì presente è entusiasta del proprio particolare settore di lavoro.

  

  Il mio ultimo saluto è stato per due donne di rilievo, Kat e Robin della Canonical. Semplicemente vederle nell'area esposizioni mi ha incoraggiato. Loro rappresentano il tipo di professionalità che spero riempirà il campo nei prossimi 8-10 anni.


  

  



  Lettere


  Due anni fa un mio amico organizzò una festa di compleanno. Mentre la festa proseguiva non potei essere d'aiuto perché stavo dando un'occhiata allo schermo del computer di suo padre. Sapevo che non era un Mac ma sapevo anche che sicuramente non stava girando Windows. Allora mi ricordai di aver letto un articolo su Internet che parlava di Linux. Preso dalla curiosità gli chiesi: "É quello Linux?". Lasciai la festa con i CD di Debian, Knoppix e MEPIS.

  

  La scorsa estate ho ricevuto un Dell Inspiron 1520 per sostituire il mio datato HP. Come la maggior parte dei computer moderni, era equipaggiato con Windows Vista. Per un po' tutto andò bene. Due mesi dopo decisi che ne avevo abbastanza. Avendo reinstallato Vista tre volte e avendo perso, durante queste operazioni, un'intera raccolta di CD che avevo copiato sull'hard disk, decisi che era il momento di cambiare.


  Così ho fatto una copia di sicurezza di tutto e ho tirato fuori quel vecchio CD Debian. Deve essere meglio di questo. Sono stato subito intimidito dalla mancanza di interfaccia grafica nella procedura di installazione. Non sapendone abbastanza per continuare con l'installazione, ho annullato al momento del partizionamento.



  Sentendomi scoraggiato, passai a Google per vedere cosa potevo trovare. Il mio primo incontro con Ubuntu fu su Distrowatch.com. Era in cima alla lista, così decisi di provarlo. Guardare le immagini e le recensioni mi rese davvero entusiasta. Ho anche letto che Google lo utilizza internamente.



  Hey, se Google lo usa, deve essere buono! Durante l'inverno decisi di dare a Linux un'altra opportunità. Ho masterizzato una copia della versione 7.10 e ho avviato. Tenni le dita incrociate mentre la barra di progresso del processo di installazione avanzava lentamente. Fui stupito che tutto funzionò alla perfezione senza problemi. Vista aveva bisogno di tre CD di driver per poter avere le funzionalità base di rete, ma Ubuntu aveva fatto funzionare il wireless senza difficoltà.



  Ubuntu ha tutto quello che cercavo. Stabilità, sicurezza e facilità di installazione. Ora tutta la mia famiglia usa Ubuntu, anche mio fratellino di nove anni. Grazie all'intera comunità Ubuntu, specialmente a quelli che mi hanno aiutato in quei lunghi giorni invernali su Ubuntuforums.org.

  

  Travis Whitaker


  


  

  Voi non potete immaginare quanto sia felice ed eccitato di essere in grado di imparare, usare e parlare ad altre persone di Ubuntu. Per primo provai Kubuntu 6.06, ma non ebbi molto successo. Adesso sto usando Ubuntu 8.04 con Wubi dentro Windows XP. Non posso ancora capacitarmi di quanto Ubuntu sia migliorato da Kubuntu 6.06.

  

  Un giorno, dopo essere stato dal mio chiropratico, andai in un negozio di computer locale per dare un'occhiata. Mentre ero là, iniziai a parlare con la commessa. Mi disse che aveva installato Ubuntu in un PC che si era costruita da sola. Ora, qui è il dunque: mi disse che quando decise di costruire un computer con Linux fece così: raccolse tutte le informazioni di cui aveva bisogno per iniziare l'assemblaggio senza problemi, ad es. schede video, schede audio, ecc.. ma solo quelle compatibili con la distribuzione che avrebbe poi utilizzato. Quando ebbe tutto il materiale e le informazioni, iniziò a costruire il suo computer. A quanto mi ha detto, è così che costruì il suo attuale PC Ubuntu.

  

  Al momento, sto considerando attentamente l'Asus EEE PC, mi è capitato di recuperare una copia di "Ubuntu per principianti". Il libro è appena più grande dell'Asus! Spero di comprare presto il "Manuale ufficiale Ubuntu". Per finire, posso solo dire che quando i costruttori di stampanti, WiFi, ecc.. faciliteranno il plug'n'play nelle distribuzioni Linux, vedremo Windows abbandonato nella polvere.

  

  Congratulazioni e continuate con il bel lavoro che state facendo.

  

  Joseph Barr
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  Sabato 23 agosto 2008 ho sposato la mia fidanzata Elena. Ecco le foto del grande giorno. Notate la spilla nella mia asola: è una spilla con il logo Ubuntu. Ho preferito mettere quella piuttosto del solito fiore di carta o vero.

  

  Sergei Agarkoff

  

  Ed: Un uso eccellente di una spilla Ubuntu e congratulazioni a voi da tutti noi di Full Circle!


  


  

  Ho apprezzato la guida a Gnome-Look nel numero 16, è bello trovare tutto riassunto insieme. C'è però una piccola informazione mancante. Il modo più semplice per installare le schermate di Grub e Usplash è con un pacchetto chiamato startupmanager. Dopo che è stato installato c'è un collegamento in Sistema > Amministrazione > StartUp-Manager. Andate nella tabella Aspetto e vedrete i controlli per gestire le schermate di Grub e Usplash. Ci sono ovviamente modi per cambiare le schermate di Grub e Usplash manualmente, ma l'interfaccia grafica di startupmanager è molto più semplice e veloce.

  

  Mocha


  


  

  Sono un ragazzo inglese, uso Ubuntu 8.04 e mi piace molto la vostra rivista perché mi aiuta parecchio in diversi ambiti inerenti il computer.

  

  Una delle principali attrattive, tuttavia, era Giovani Ubuntu. Nell'ultimo numero non era presente. Per favore ditemi se è una cosa temporanea (in tal caso sono a posto) o permanente. Se è permanente allora per favore annullate questa decisione.

  

  Colm Murphy

  

  Ed: Non aver paura Colm, e tutti gli altri fan di Giovani Ubuntu. Giovani Ubuntu non era presente negli ultimi numeri perché Samuel aveva degli esami e Andrew era occupato a saltellare con le star all'OSCON. Ritornerà quando Samuel sarà nuovamente disponibile, promesso!


  

  



  Domande & Risposte


  Scritto da Tommy Alsemgeest


  
    	D Utilizzando Rhytmbox, non riesco a modificare nessuno dei tag presenti sul mio iPod o dei file mp3. Esiste una qualche soluzione al problema?


    	R Riesci a modificare i tag utilizzando qualche altro lettore musicale? Potresti provare ad utilizzare un altro media player o un organizzatore, come ad esempio Kaffeine. Inoltre, controlla che i tuoi file siano effettivamente mp3 e non un altro tipo che non supporta i tag.


    	



    	D Ho qualche problema con i giochi quando utilizzo WINE. Quando faccio partire un gioco, lo schermo si divide in due zone, ognuna delle quali mostra le stesse immagini ad una qualità pessima. Recentemente ho rimosso il mio driver video, quindi ho installato fglrx e, dopo aver riavviato, la massima risoluzione dello schermo che riesco ad ottenere è 800*600 con 75 Hz come frequenza di aggiornamento dell'immagine. Il monitor originariamente aveva una risoluzione di 1280*1024*75. La mia scheda video è una Radeon X600.


    	R Se stai usando Hardy Heron, dovresti riavviare il computer e, se appare il conto alla rovescia, premere il tasto Esc. Dal menù che appare, seleziona la modalità Recovery e seleziona l'opzione di ripristino della grafica, questo dovrebbe risolvere in automatico il problema. Se invece non ottieni il risultato sperato, ripeti la stessa procedura che hai appena fatto, ma questa volta apri un terminale in modalità root e digita:

    

    dpkg-reconfigure xserver-xorg

    

    Così dovresti riuscire a risolvere.


    	



    	D Tutto funziona a dovere sul mio account personale, ma ne ho realizzato anche uno per mia moglie e quando voglio attivare gli effetti "extra", nel pannello degli effetti visivi del suo account, una schermata dice che non si possono abilitare. Utilizzo un Inspiron 6000 con Ubuntu 8.04.


    	R Potresti provare ad installare compizconfig-settings-manager e vedere se riesci a cambiare le impostazioni da lì. Inoltre, installa fusion-icon e prova a lanciare Compiz attraverso questo. Entrambi i programmi che sono presenti nei repository.


    	



    	D Ho dei problemi nel riuscire a far funzionare la mia scheda audio Sigmatel 92xx. Riesco a sentire i suoni in fase di test, ma è come se Ubuntu non sopportasse questa scheda. Che scheda audio dovrei comprare per poter sentire i suoni con Ubuntu?


    	R Dovresti riuscire a sentire l'audio. Non acquistare nulla finché non hai accertato che effettivamente si tratta di un problema hardware. Potrebbe semplicemente essere un problema di configurazione. Prova a cambiare le impostazioni audio presenti nel menù. Visto che riesci a sentire i suoni in fase di test, credo che sia semplicemente un problema con i programmi che stai utilizzando. Vai nelle impostazioni del programma, e anche lì cambia le impostazioni audio. Anche se volessi tagliare corto e comprare una nuova scheda, ne puoi trovare diverse a circa $20 (~£10). Se non sai come installare una nuova scheda, puoi anche comprare una periferica audio USB.


    	

    


  


  Il mio Desktop
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  Sono un utente Linux da 12 anni. Ho iniziato con Slackware e l'ho usato per circa cinque anni poi sono passato a Debian e negli ultimi anni ho utilizzato Ubuntu.

  

  Lavoro in una delle più grandi compagnie IT del mondo e, ovviamente, gli impiegati sono rivolti verso i prodotti Microsoft. Essendo uno sviluppatore Java e visto che tutte le mie applicazioni girano su server Debian, il bisogno di avere Linux sul desktop era enorme per me. Così, quando abbiamo ricevuto i nuovi portatili al lavoro ho deciso di installare Ubuntu sulla mia macchina nuova. Funziona tutto con le applicazioni Linux, tranne il calendario (Exchange 2007). Ma invece di usare Exchange uso il mio Google Calendar con Lightning. A lavoro uso un desktop molto semplice poiché deve essere veloce ed accessibile.

  

  Gustav Ruthgård
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  Uso Linux da circa due anni e solo dall'anno scorso ho scoperto Ubuntu e ne sono rimasto innamorato. Ho usato RedFlag, Ubuntu 7.10 e OpenSUSE. Adesso sto usando Ubuntu 8.04 ed ho scoperto che risolve quasi ogni problema che mi si presenta. Ho personalizzato il mio sistema utilizzando i Google Gadgets e AWN. Il tema che uso è una versione modificata da me del tema Human così come il tema AWN (Curved Glassy Mint AWN). La barra laterale è Google Gadget che si può scaricare dal sito ufficiale di Google. Il pc è un portatile Tsinghua Tongfang T21 con un Celeron M 1,6GHz, 1GB di RAM e una scheda video integrata con una risoluzione di 1024x768.

  

  Mario Yuan


  

  



  I migliori 5 notificatori di email


  Scritto da Andrew Min


  Mail Notification
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  http://www.nongnu.org/mailnotify/

  

  Mail Notification è un semplice notificatore per Gnome che si posiziona nell'area di notifica. Può controllare più caselle di posta, supporta tanti formati compresi POP3, IMAP, Maildir, mbox e mh e funziona anche con programmi di posta come Evolution, Thunderbird, Gmail, Yahoo Mail, Hotmail e Sylpheed. Si può anche configurarlo per far udire un suono o aprire o marcare come letto il messaggio. Tutto sommato, è difficile chiedere di più a uno strumento per il controllo della posta.

  

  Per installare Mail Notification prelevate il pacchetto mail-notification dai repository universe.

  


  


  KBiff
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  http://www.granroth.org/kbiff/

  

  KBiff è per KDE quello che Mail Notification è per Gnome. Basato su Biff, il famoso strumento a riga di comando, KBiff è un potente controllore di email che potete avviare da desktop (come xbiff) o dall'area di notifica Kicker. Supporta POP3, IMAP, nntp, mh, maildir e mbox; se ne possono personalizzare le icone e può eseguire comandi e far udire suoni quando arriva un messaggio. L'unica pecca è che è disponibile solo per KDE3, non per il nuovo KDE4, in cui non si integra bene, diversamente da Korn (alla pagina successiva).

  

  Potete installare KBiff usando il pacchetto kbiff nei repository universe.

  


  


  Korn
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  http://www.ph.unimelb.edu.au/~ssk/kde/korn/

  

  Se pensate che KBiff sia troppo complicato, provate Korn. Basato anch'esso su biff e chiamato così per via del gruppo musicale KoRn, questo potente controllore di email fa tutto ciò che fa KBiff, ma con più facilità d'uso. I protocolli supportati includono DCOP, IMAP, KMail, mbox, nntp, process e qmail. Diversamente da KBiff (pagina precedente), supporta molteplici account in una sola applicazione. Le opzioni di configurazione degli avvisi vi consentono di scegliere se far udire un suono, mostrare un messaggio, eseguire un comando o cambiare un'animazione.

  

  Korn è disponibile nel pacchetto korn del repository universe di Ubuntu.

  


  


  CheckGmail
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  http://checkgmail.sourceforge.net/

  

  CheckGmail è il notificatore per Gmail definitivo. Ha tutte le funzioni "normali", incluso l'avvio di comandi quando arriva un nuovo messaggio. Ma, essendo specifico per Gmail, ha anche tante altre funzioni tipiche di Gmail, come l'apertura dei messaggi, la loro cancellazione e archiviazione, il tutto senza aprire un browser. Può anche essere configurato per controllare la posta con una certa etichetta e funziona con Gmail di Google App. Può anche far lampeggiare i vostri LED (all'arrivo di un messaggio) se configurato correttamente.

  

  Per installare CheckGmail, usate il pacchetto checkgmail dai repository universe.

  


  


  KGmailNotifier
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  http://www.kde-apps.org/content/show.php/KGmailNotifier?content=55375

  

  Se siete fan di Gmail ma non sopportate di dovere avviare un'applicazione per Gnome come CheckGmail, KGmailNotifier è un'ottima alternativa. Non è configurabile come CheckGmail, ma ha funzioni di notifica audio e LED, un comodo avviso per le nuove email e il supporto per la loro apertura nel browser preferito. Come per KBiff, gli autori (purtroppo) non hanno ancora trovato il tempo di effettuare il porting su KDE4, ma rimane un comodo strumento.

  

  Potete installare KGmailNotifier usando il pacchetto kgmailnotifier nei repository universe.

  

  Andrew Min è un appassionato di Linux fin da quando ha installato per la prima volta openSuSE su VMWare. Maggiori informazioni su di lui a: http://www.andrewmin.com/


  

  



  ﻿FULL CIRCLE HA BISOGNO DI TE!


  Una rivista non è una rivista senza articoli e Full Circle non fa eccezione. Ci servono le vostre opinioni, storie e desktop. Servono anche recensioni (giochi, applicazioni e hardware), how-to e guide (su qualunque soggetto K/X/Ubuntu) e ogni domanda o suggerimento che vorreste rivolgere.


  Siamo sempre in attesa di vostri nuovi articoli da pubblicare nella rivista Full Circle. Per articoli, guide, idee e per le traduzioni della rivista , date un'occhiata al nostro wiki:



  http://wiki.ubuntu.com/UbuntuMagazine


  Inviateci i vostri articoli a:

  articles@fullcirclemagazine.org


  Se desiderate inviarci delle notizie, scrivete a:

  news@fullcirclemagazine.org


  Inviate i vostri commenti o esperienze Linux a:

  letters@fullcirclemagazine.org


  Inviate le revisioni Hardware/software a:

  reviews@fullcirclemagazine.org


  Le domande sulle interviste future vano inviate a:

  questions@fullcirclemagazine.org


  Le liste e le foto dei desktop/PC photos vanno inviate a:

  misc@fullcirclemagazine.org


  ... se avete domande, visitate il nostro forum:

  misc@fullcirclemagazine.org


  Full Circle Team:


  Caporedattore - Ronnie Tucker -

  ronnie@fullcirclemagazine.org


  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org


  Direttore delle comunicazioni - Robert Clipsham -

  mrmonday@fullcirclemagazine.org


  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Correttori di bozze:


  Mike Kennedy

  Lucas Westermann

  Gord Campbell


  Il nostro ringraziamento va a Canonical, al team marketing di Ubuntu e ai molti gruppi di traduzione nel mondo.


  

  

  

  



  IL GRUPPO FCM ITALIANO


  ENTRA ANCHE TU NEL GRUPPO FCM


  La rivista Full Circle nasce da una idea della Comunità degli utenti di Ubuntu e vive del lavoro di coloro che hanno scelto di dedicare parte del loro tempo libero alla riuscita di questo progetto. È un progetto veramente aperto: tutti possono collaborare, in un modo o nell’altro. C’è chi scrive gli articoli, chi li corregge, chi li traduce, chi li impagina e così via.


  Anche tu puoi collaborare attivamente alla continua crescita di questa rivista, il cui unico scopo è la diffusione della cultura del Software Libero.


  Se conosci l'inglese e il Software Libero è la tua passione, puoi collaborare:


  
    	Scrivendo articoli in inglese;


    	Traducendo in italiano i testi;


    	Revisionando i testi;


    	Impaginandoli con Scribus;



    	Impaginandoli con Sigil.

  


  
    
      Se vuoi saperne di più, visita la paginaParteciparedel nostro wiki.
    


    Oggi partecipare è ancora più facile!

  


  
    Hanno collaborato alla realizzazione di questo numero:

  


  Traduttori


  
    Paolo Garbin paolettopn@ubuntu-it.org Aldo Latino aldolat@ubuntu-it.org Dario Cavedon dcavedon@gmail.com Cristina Franzolini forkirara@gmail.com Antonino Arcudi antonino.arcudi@gmail.com Lidia Pellizzaro lidia.pellizzaro@gmail.com Teo Cocetta teo666@linuxmail.org Marco Letizia letissier85@gmail.com Michele Azzolari michele.azzolari@gmail.com Vito Tigani

    
      	Paolo Garbin



      	Aldo Latino



      	Dario Cavedon



      	Cristina Franzolini



      	Marco Letizia



      	Antonino Arcudi



      	Lidia Pellizzaro



      	Teo Cocetta



      	Michele Azzolari


      	Vito Tigani


    


    Revisori


    
      
        	Aldo Latino



        	Lidia Pellizzaro



        	Dario Cavedon



        	Vito Tigani



        	Cristina Franzolini



        	Michele Azzolari


      


      Impaginatori PDF


      
        
          	Paolo Garbin


          	Cristina Franzolini


          	Aldo Latino

        

      


      Impaginatori Ebook


      
        
          	Diego Prioretti


        

      


      Addetto alle comunicazioni:


      
        
          	Maurizio Moriconi

        

      


      Referente del gruppo di lavoro italiano:


      
        
          	Paolo Garbin

        

      

    

  

  


  I collegamenti per scaricare tutti i numeri di Full Circle Magazine in italiano li trovi nel nostroArchivio.


  Cerchi un articolo pubblicato su FCM?


  Nel wiki trovi anche l'Indice generale di tutti i numeri pubblicati, comprensivo di titolo, autore e pagina dell'articolo.Fai clic quiper consultarlo!

  


  Questa rivista è stata tradotta dal Gruppo FCM della comunità Ubuntu-it.


  Per ogni altra informazione visitate il nostro sito web: http://wiki.ubuntu-it.org/Fcm.
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